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About Jands

Jands is an Australian owned privately held and proudly independent company founded in 1970. The company manufactures and distributes the world’s most recognised brands of Audio, Lighting and Staging products primarily for the entertainment and exhibition industry. With headquarters and manufacturing facilities in Mascot, Sydney, New South Wales, a factory in Melbourne and offices in Brisbane and Perth, Jands employs over 120 people across Australia.

Jands were among the early Australian pioneers of the modern staging and entertainment technology industry. Supplying the equipment needs of elite international touring market and emerging Australian venues, Jands developed a business around delivering quality and reliable solutions to our customers technical problems

“Providing innovative yet reliable solutions to the many problems faced by our customers is fundamental to growth” is the corporate philosophy that underpins our continual product development process.
Jands lighting control consoles are exported worldwide, are found in some of the most prestigious international venues and are used by a large number of high profile international touring artists.

How to Use These Training Notes

These training notes are for use principally during training sessions held by authorised Jands Vista trainers. However there will be times when user may want to refer to their notes after the training session has been completed.

To help users increase their knowledge, these notes cross reference the user manual and the training videos. 

References to the training videos are indicated by
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followed by the video number. Videos can be downloaded from http://jands.com/support/training/.

References to the user manual are indicated by 


 followed by the chapter number. The user manual can be downloaded from http://jands.com/downloads/Vista_V2_1B_User_Guide_web.pdf.

Subject headings that are followed by (Advanced) are covered in the Jands Vista Advanced Training Course
Your Vista Trainer

<insert trainer biography here>
Getting to know Vista – The Basics

This section covers some fundamental operations on the console, including the console hardware and GUI. All topics are optional based on prior learning.
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Using a Wacom pen tablet


Appendix 10
1. Handling the pen – hold it low and lean on the screen for comfort and accuracy

2. Left-click & right click

Console Controls


Chapter 11
Coloured modifiers

The coloured modifier keys on the console are used in conjunction with another key press to perform specific actions in Vista. e.g. Holding Yellow while adjusting a parameter will fan that parameter. 

The coloured modifier keys are also mapped to the keyboard as follows:

Red = Shift

Yellow = Ctrl/CMD (Mac)

Green = Alt

Blue = Ctrl+Alt/ CMD + Alt (Mac)

Function keys

The function keys are the unlabelled keys at the top of the console:

L5/T2/T4 - 12 buttons are located above the tablet.

I3/S3 - Five Buttons at the top of the console

S1 - Six Buttons at the top of the console. 

These function buttons are mapped directly to the soft function keys in the console software.

LR Button

The LR button provides access to the right click function for T series and L5 consoles. 
DBO & Grandmaster

The DBO and Grandmaster are a global control for the output intensity of your fixtures. The DBO button will blackout the intensity of all fixtures. The grandmaster will scale the output intensity of fixtures. 
Using the Interface (GUI)


Chapter 3
Window navigation

There are 6 main programming windows in Vista.

· Patch

· Console

· Fixture Chooser

· Timeline

· Playback Control 

· Output
Tabs

Vista frequently utilises tabs in the software. It is important to understand the concepts of the tabs and how to use them when programming. The rule of thumb is; the tab that you have active is where the programming will be inserted. For example if you have the live tab active, your changes will be made in live but if you have a cuelist tab active, you are directly editing into that cuelist. 

Softbuttons

The soft buttons are editable the 12 buttons at the top of the console. These are completely user customizable and can be changed by right clicking the desired button and selecting a new action. 

1. Sidebar

2. Dropdown menus

3. Right-click context menus

The right-click context menus are where you will find many of the advanced programming operations in Vista.

4. Text boxes

5. Numeric “Slider boxes”

TIP: if you are using the Numeric Slider Boxes and would like to scroll through values, just click and drag your mouse up or down. 

Creating, Loading and Saving Show Files


Chapter 2-4
1. Creating a show
2. Loading existing shows

3. Saving shows

4. Importing and exporting shows

Importing and exporting shows is used to move show files between the different operating platforms.

Generic Fixture Model

It’s a part of the software that works in the background and enables all fixtures, no matter what type or manufacturer to be treated the same way.

With Vista, you can replace a fixture and you don’t have to do any re-programming. Why? Because everything you’ve programmed is stored in generic form rather than as specific DMX channel values. For instance if you’ve programmed the lights to be Red, Vista can send that information to any light and achieve the same colour.

Vista uses a defined set of features that apply this generic fixture model, for common programming being between all fixtures, these are:

· Intensity

· Strobe

· Position

· Colour Mix

· Generic Gobo - Gobo Wheel Selection and Rotation

· Frost

· Iris

· Zoom

· Focus

· Frame

(This is a generic feature set and doesn't take into account custom controls within each feature such as zoom channels with inbuilt focus etc...)

Every other feature is treated as custom and the programming will only apply to the fixture it was built on. 
Patch

Once you’ve got your Vista system connected and powered up you can patch your fixtures the way you want them using the Patch window.

If it’s not already open click on the Patch icon or select the ‘Patch’ option from the Window menu, Vista displays the Patch screen:

This is where you set up all the fixtures in your rig. You tell the Vista which DMX channels each fixture is assigned to, and in which universe, and can set a range of parameters to customise how each fixture operates.




Video 2

 

Chapter 4
Patching fixtures to DMX addresses


Chapter 4-1
1. Fixture Type List & Search

2. Quantity of fixtures to patch

3. Drag’n’drop to desired addresses

4. Universe tabs

5. Using the Sidebar Patch tab

a. Name

b. Fixture Number

c. Multi-patch

d. DMX Universe & Address

e. Absolute address

f. Spacing

6. Renaming and renumbering fixtures after you’ve patched them (right-click)

Exercise - Patch the show:

· 10 x Mac 2000 Wash (Color Wheel) 

Start : Universe 1 Address 1 

· 10 x VL2000 Spot Mode 4 

Start: Universe 1 Address 221 (Spacing 20)

· 10 x Robe Colorspot 700 AT Mode 4

Start: Universe 2 Address 1 

· 24 x Dimmers (Ch. 201)

Start: Universe 3 Address 1

· Patch your fixture on the desk to Universe 8 Address 1 (Ensure the DMX is connected to DMX port 2 on your console)
Connect Universes
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Chapter 4-13

Before Vista will output any DMX the universe must be assigned to the correct output port. Either via a hard DMX port on the back of the console or via a DMX over Ethernet protocol e.g. Artnet. 

Exercise – Assigning DMX Universes

Assign Universe 8 to DMX Port 2 on the console you are using. 

List View (Advanced)

The list view is a way to view the patch in a list format. You can edit the Address of existing fixtures here. 

However you cannot add new fixtures to your show in the List View. 

DMX View (Advanced)

The DMX View allows you to view the DMX output of the console in Raw DMX format. 

Transforms (Advanced)

Transforms allow you to apply individual parameter based changes to a fixture. Standard Transforms are:

Preheat - Sets a minimum level for the intensity

Limit - Sets a maximum level for the intensity

Dimmer Curve

Invert Pan/Tilt and Swap Pan/Tilt. 

Advanced Transforms (Advanced)

By using the advanced button, you can also apply a transform to a specific parameter for the fixture, such as the Gobo Wheel or Colour mix. 

Strike, Douse & Reset
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If the fixtures being used are the type that have remote-controlled lamp power and reset controls, these are found in the patch toolbar.

· Select the Fixture.

· Click the Strike Douse or Reset button.

You can strike fixtures in groups or individually and you can stagger the strike to save your power supply from inrush current.

Cloning Fixtures
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Cloning allows you to create an exact copy of a fixture to add to your show. The copy will take all of the programming fixture from the host fixture and allow you to repatch it to another address. 

Once cloned, the copy is its own independent fixture and no longer contains any links to the host fixture. 

Changing Fixture Types (Advanced)
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Changing Fixture Types allows you to change the type of a fixture after it has been patched. When changing a fixture type the generic fixture modeler is used to determine which features will move from the old fixture type to the new one. Generic features will move across but custom features will be lost. 

Changing a fixture type can be used on a one to one basis or can be conducted for all of a particular type of fixtures.

NOTE: Beware when changing fixture types that this action cannot be undone.

Exporting and Importing Patch Information (Advanced)
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Vista allows for the import and export of Patch information. This is conducted via a .csv file. 

The options for Import and Export can be found under the patch menu.
Fixture Chooser

In this section we look at creating the fixture chooser layouts. 
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Chapter 5

Getting the fixture chooser “right” for your show will greatly increase the speed at which you can program, so it is an important step in show setup. Don’t just think about where the lights are located, think about what they’re used for, which are used together, etc.

Arranging fixtures in a layout
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1. Layout views

2. Layout properties and options

3. Icon Colours/Gel Colours

4. Adding Layouts

5. Manage Layouts Window

6. Configuring a layout in Manage Layouts

7. Renaming layouts

8. Showing/hiding fixtures

9. Lock the icons!

10. Arrange options in the right-click menu - Align, Distribute. 

11. Customising the GUI

12. Themes
Adding Notes

[image: image20.wmf]Chapter 5-10
You can add text boxes to the fixture window to help identify different fixture types or areas. Notes can be either attached to an object on the layout, such as a fixture, or can be independent.

Selecting and Moving Fixtures

[image: image21.wmf]Chapter 5-12
The simplest way to select fixtures is to click on the fixture or group icons one by one but Vista provides three selection tools and several options to make more complex selections.
1. Selecting fixtures by clicking or drag “rubber-band” (as above)

2. Extra selection controls – Lasso and Drag-Over

Exercise – Setup the chooser layouts

Setup three different layouts. 

Layout 1 Movers

This layout will contain all of your moving light fixtures. The VL2000 Spots, Color Spot 700's and the Mac 2000 Washes. 

Arrange them in their fixture type groups. 

Colour the icon for each fixture type a different colour.
Layout 2 – Dimmers

1.
Create a layout that contains only the 24 Dimmer Fixtures. 

2.
Layout the dimmers in 4 Groups of Six. 

3.
Add the following details to each group:

Group 1 

Add Note Blue Wash

Icon Colour = Blue

Gel Colour = Blue

Group 2

Add Note Amber Wash

Icon Colour = Amber

Gel Colour = Amber

Group 3

Add Note Red Wash

Icon Colour = Red

Gel Colour = Red

Group 4

Add Note Blue Wash

Icon Colour = Blue

Gel Colour = Blue

Create the following layout:
Layout 3 - Mover Positions

Create a Layout that contains all of the moving lights. 

Add 3 notes - One for FOH, One for Mid Truss, One for Rear Truss.
Controlling fixtures

This section looks at how to select and control your fixtures.
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At this stage we are working in the Live Tab. The Live Tab is functions in a similar way to the programmer on other consoles. When looks are created in the live tab they must be stored somewhere in the console either to a preset or a cuelist. The programming is only kept in the live tab until a clear action is performed then it is discarded. 

The live tab has the highest priority in the console. Any change you make here will override almost anything in the console. 
1. Feature palettes onscreen

The main way to control your fixtures in vista is by using the feature palette sidebar. The sidebar is broken up into feature groups and an All group.

a. The all palette contains a breakdown of the most used parameters in fixtures. These are also the parameters used as part of the generic fixture modeller.

b. Colour Wheels

c. Colour Picker

d. Gobo Wheels

2. Using Encoder Wheels

a. I/POS super playback mode

b. Parameter Categories - Scroll through options with multiple presses.

c. Clear/Home/Zero/Half

d. Using encoder wheels with Feature Pallette Sidebar.

3. Fine control

a. Hold Red Modifier while changing a parameter either in the feature palette sidebar or on the encoders. 

4. Fan

a. Hold Yellow Modifier while changing a parameter either in the feature palette sidebar or on the encoders. 

5. Live Time

a. Live Time is the time that a parameter while change over when activated in the live tab. 

b. Live Time Fader in super playback - Scales from Set Live time down to zero seconds

6. Cut/copy/paste between fixtures

a. Ctrl+C and Ctrl+V 

b. Paste Special: Ctrl+Shift+V

7. Next/Prev fixture buttons
a. Easily scroll through selected fixtures

b. Hit both buttons to select all

c. Works with the selection order

8. Highlight

9. Selection order.

a. Number in the blue circle once a fixture is selected.

b. Changes with option in menu bar

c. Very important as this determines how Fx are applied and the ordering of events in the timeline.
Exercise - Create your first lighting look.

1. Select your fixture 

2. Pan and Tilt to a convenient position

3. Change the colour to Blue

4. Tweak the colour with the RGB/CMY sliders

5. Add in a gobo. 

6. Focus the gobo. 

7. Start the Gobo Rotating.
Custom Features on Encoders. 

Manual Reference??????
As of v2.3 Vista offers users the ability to create pages with your choice parameters on encoders.  This can be useful for quick access to 3 commonly used features together (eg, gobo, gobo index, focus) or for mapping raw parameters that are not otherwise available on encoders such as media server content selection.

With some fixtures selected, from your console IPCG controls, press the custom softkey as highlighted in red below. 

Pressing the bottom left softkey (highlighted green) will open up the encoder customisation window. (this can also be accessed from the console menu later).

In the top dropdown, choose the fixture you want to assign features for.  Then for each of the 3 encoders, click the cell to bring up a dropdown as shown above.  You can then choose a feature for that encoder.  Up to 6 pages of features may be assigned for each fixture.  To toggle pages on the console, press the custom softkey repeatedly. 

Quickpicker

The Quick Picker is the place where we store all of the building blocks for our Shows such as groups presets Fx and Cue lists, we call these components. Each slot in the QP can be filtered to any type of component. 

· Using the QP Dropdowns

· Using the Filter Dropdowns

· Setting up a Quick picker for a touch screen. 

· Adding a new quickpicker
Groups
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Chapter 5-44

To make it easy to control all the fixtures in your rig Vista automatically creates groups for each fixture type that you patch. These groups are not editable. 

A group can consist of any number of any type of fixtures; it’s entirely up to you to you put in a group. Some typical groups might be all the even or odd fixtures of one type, all the fixtures on the back truss or all the fixtures you’re using on one particular part of the stage

· Creating Groups

· Updating Groups

· Renaming Groups
Presets
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Chapter 5-45
Why use presets?

Presets are “building blocks” that you use to create cuelists. They represent common sets of attributes that you know you’re going to want to use over and over again, such as a particular colour (e.g. red) or position (e.g. on the drummer.)

Presets are useful for two reasons. First with presets you can quickly assign Intensity, Position, Colour Gobo, Beam and other values to any number of fixtures without having to adjust the settings individually for each one. Second, if you store your cues using presets you can quickly update all your programming without having to edit every cue. This is because presets use referenced data, when you store a preset.
Creating Presets

To create a preset:

1. Create the desired look onstage from the previous exercise

2. Right-click in the “Presets” QuickPicker and click “Create New Preset” (you’ll notice your groups are available in the QP too!)

· QP filtering

3. Label the preset, and set the desired filtering options (make it work only on position) and click OK

· Filtering Options

· Selected Vs All Fixtures

Note if using the QP filtering, the presets get filtered automatically
Global and Fixture Type defaults for presets

“Create default for fixtures”? If you want to be able to apply the preset to other fixtures, as well as the ones you’ve programmed so far, tick these boxes! Create a colour preset as an example.

Exercise – Colour Presets

1. Create some colour presets using one of the VL2000 fixtures, setting the “Global” default

Updating Presets

To add new fixtures to a preset, or change the values for existing fixtures, apply the changes onstage, right-click on the preset and choose “Update Preset”.

· “Merge” vs “Replace” option
Exercise – Updating Presets 

1. Create a Blue Global Preset for the Colourspots

2. Find a fixture type that doesn’t match colours well and adjust one of them to suit, making this the “type” default

3. Update the Preset using the Replace Option
Editing Presets in the Timeline

Once a Preset is created the preset can also be edited in the timeline. Editing in the timeline makes it easier to see in detail all the values that are contained within the preset. 

· Global Values Events

· Fixture Type Values Events

· Fixture Events - always takes priority over Global or fixture type events.
Exercise – Global Values Events

1. Open the blue preset you just created in the timeline. (Right Click and click edit)

2. Edit the Global value to Green. 

3. Switch to the fixture chooser and add in another fixture in green

4. Switch back to the timeline and notice the added discrete fixture event

Exercise – Fixture Events

· Create 3 position presets using some of the fixtures.

· Position 1, 2 and 3

· Create 4 Global Colour Presets using one Fixture

· Red

· Green 

· Blue

· Magenta

· Create 2 Gobo Presets Using the Colorspot 700's

· Gobo 1 Wheel 1

· Gobo 4 Wheel 2 Rotating

· Create a state using all of the fixtures and store this as a preset.

Extracts

[image: image28.wmf]

Chapter 5-50

Extracts are unique presets that also include timing information. They are very handy tool for applying unique timing in a live situation or to store timing information to be later inserted into cues. 

· Creating Extracts

· Editing Extracts in the timeline

Exercise – Creating Extracts
1. Create an Extract for fixtures 101 through 110 where each fixture turns on in red one after the other over 25 seconds.

2. Create an Extract for Fixtures 201 through 210 where they turn on from the centre out over 3 seconds

3. Create an Extract for Fixtures 201 through 210 where they add a gobo in from the ends toward the centre over 3 seconds. 

Clear functions and parameters

When you are finished working with a fixture or parameter in the live tab you can clear the programming out of your fixtures by using the Clear Function. 

Under the Tools menu you can find all of the Clear options:

· Clear All - Clears all programming from the live tab

· Clear Selected - Clears programming from the selected fixtures

· Clear Intensity - Clears the intensity parameter only

· Clear Position - Clears the position parameter only

· Clear Colour - Clears the colour parameter only

· Clear Gobo - Clears the gobo parameter only

· Clear Beam -  Clears the Beam Parameter only

Home Fixtures

When you home your fixtures you return the fixtures to their default value, e.g. 50 Pan 50 Tilt. 

NOTE: There is a big difference between Clear and Home. When you clear your fixtures the programming is removed from the live tab, when you home your fixtures the home events are inserted into the live tab or cuelist. This means that this home value can be recorded or inserted into your cues and presets. 


Tools > Home Selected

· Clear Functions in Feature Palette Sidebar

· Home Functions in Feature Palette Sidebar

· Stop Fx functions in feature palette Sidebar. 

Cuelist Basics



Video 6
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Chapter 6
Once you’ve set up your patch, arranged your fixtures, assigned them to groups and created the presets you want, you’re ready to create a Cuelist.

This is where the Vista differs in a big way from traditional keypad controlled lighting consoles, because instead of telling what you want by entering a string of numbers, you do it all visually, on a large screen using the pen or mouse and the hardware controls.

Live & Cuelist Tabs 
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Chapter 6-11
Vista uses “tabs” in the programmer to determine what you are editing:

Vista uses “tabs” in the programmer to determine what you are editing:

There are 4 different types of tabs you will see:

· Live Tab

· Cuelist Tab

· Preset Tab

· Extract Tab

This section will focus on storing cues into the cuelists. 


There are two main ways to store cues:

· Using the Store All or Store Part Method

· The Direct Editing Method

Store, Store Part & Update
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Chapter 6-1
When creating cues in the live tab you will need to store them to a cuelist in order to play them back later.

When working in the live tab, the first step is to build the state that we would like to store; then we use one of the following store functions to store it to a cue within a cuelist. 
Store All

This function stores all of the console output to a cue. It is like taking a snapshot of the current output and putting it into a cue. The Store All function will also store all programming from all other outputting cuelists.

NOTE:  When you use Store All on a cuelist for the first time and place it directly onto a fader, Vista automatically turns the fader into a submaster fader. It will also remove the programming from the live tab and hand the programming over to the new cuelist. 

· Store All taking control over programming

· Store using Select button (Double Hit)

· Store to  a cuelist without being on a fader

Exercise – Store All

1. Create a state with all of the Mac2K Washes. Store directly to a fader using the single press of the select button and clicking ok. Change list name to Mac2K

2. Create a new state with all of the VL2k Spots. Store directly to a fader using Store All and double hitting the Select button. Change list name to VL2K.

3. Create a state with all of the Colorspot 700 fixtures. Store using Store all and put as the second cue in the VL2kSPot Fader. 

Store Part

Store Part is very similar to Store All however it lets you be more selective with what you are storing into a fader.

You can think of the Store Part button like a Store Live button or a Store Programmer button. You can also filter out features and fixtures you don't want to include. 

· All Fixtures Vs. Selected Fixtures

· Add Merge or Replace cues. 

· Cuelist selection, append cues or new cues

· Feature filters

· Source - Live or All Output

· Cue Only Option

· Blocking Options

NOTE: Unlike the Store All button, when you use Store Part, your programming will still be active in the Live Tab. In order for the cuelist to take control you need to clear the live tab.
Exercise – Store Part

1. Create a state with all of the Mac2K Washes in the blue colour preset. Store a new cue to the Mac2K cuelist using store part, but only include the colour feature. 

2. Add some position into the Mac2K washes, Store to a new fader using store part but only include the position programming. 

3. Add in one VL2K at Full in Red. Store to the 2nd cue in the Mac2K cuelist, change the cue options to merge
Update

Update is similar to store part, however you are only updating cues that already exist in the console and not creating new ones. The update dialog gives you a notification of which cuelists your output is coming from so you can update the correct cuelist. 

Update will also move the programming from Live into the updated cuelist.
· Update Preview

· Cue Destination

· New content will go to...
Exercise - Update

1. Play both Mac2K and Vl2K cuelists back. Change the Vl2K's to red and take to 20% use the Update dialog to update the VL2K cue only.

2. Take the VL2k's to blue and full, use the update dialog to update only the intensity into the VL2K Cue
Direct Editing Method

The direct editing method is unique to Vista and allows you to directly insert programming into cues without the need to store or record. It allows for extremely fast creation and editing of cues. 

This type of editing can be compared to the way that you edit and create a Word Document. In word you create the document and type into it then save the document, it is the way we are used to working with software, wouldn't it feel wrong if you had to type the words then record each of them into the document as you go. The same process works in Vista, Create the blank cue, insert your programming and then save the cuelist. 
There’s a couple of ways to do this – start with yellow + select:

1. Create the first look in our show, in the Live tab (simple blue wash)

2. Hold Yellow and press the star button above the playback where you’d like to use your cuelist.

This opens the cuelist in the editor, where you can edit it directly. Note the new tab - In this way you can be editing different parts of your show simultaneously, just by switching between the tabs.
Tabs in action

1. Moving between Live and cuelist tab.
Having the live tab and cuelist tabs means that you can edit in the cuelist tab then move back to the live tab and make some changes to the stage without affecting what you are storing in your cuelists. 
2. Moving between multiple cuelist tabs.
NOTE: When working with tabs it is important to watch which tab you have selected as this is the place you will be inserting your programming.
Adding and Deleting Cues

[image: image33.wmf]
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Adding and deleting cues is easy using the cue navigation tiles at the top of the screen. These tiles show the progress of your cuelist and the cues within it, a blue fill shows that the cue is active. 

· Adding new Cue

· Inserting Programming into cues

· Cue Navigation 

· Link Button

Making Link Active ensures that the selected cue is always the cue that is outputting to the stage.

· Q-View

This feature allows you to preview your cue directly in the fixture chooser even if it isn't the cue you see on stage. 
Upon opening the cuelist for editing the selected cue will be the current stage (last played) cue.  Upon selecting a cue other than the currently playing (stage) cue, the console will place users in Q-View mode.
Q-View mode will show the user the current contents of that selected cue in the chooser and edits for that cue can now be made visually.  A warning indicating that you are not editing the playing cue will be shown.  In the fixture chooser, a border is drawn and a watermark indicating the cue actually being edited.

The currently playing cue is indicated by the shading of the cue tile.  The cue currently being edited is shown by a thick border around the cue tile.  In this example, Q-View is active.  The current stage cue is Cue 2, and the current cue being edited is Cue 6.

Hint: If the user wishes to see the current total output of the stage, while making changes to a later / earlier cue they can see both simultaneously by opening a 2nddockable fixture chooser window (View menu) or by switching to the live tab.
If you toggle the Q-View button off, or clicks back to the current stage cue at any point, Q-View will be disengaged and the operator can continue to visualise and edit current stage transitions in the fixture chooser. (This is the old sync behaviour)

· Play Controls

· Cue Tile Views - List View and Layout view. 

Exercise – Adding Cues

Add 4 new cues to the cuelist - 
Cue 2 - Green Wash





Cue 3 - Blue Wash





Cue 4 - Red Wash





Cue 5 - Magenta Wash

Default cue timing

The default cue time bar allows you to edit the default time for the cue you are working with. Any event that hasn't been edited will change with the default time but any event you have already changed will respect your timing. 

· Editing the default timing

· Expanding the default timing

· Custom default timings (Advanced)

Merging Cues (Advanced)
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Merging cues allows you to combine multiple cues into one to clean up programming or edit your show.
Exercise – Merging Cues

· Create two new cues

Cue 6 - A fixture tilts upwards


Cue 7- the same fixture changes colour

· Merge the two cues together and watch the result
Inserting Cues

· Insert before cues

· Insert After Cues

· Append new cue at the end of a cuelist
Cut, Copy & Paste Cues
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Copying and pasting cues allows you to save time programming by reusing cues that you have created multiple times. 
· Drag Copy

· Drag + Shift Copy

· Move Cue

· Copy Cue

· Paste entire look
This pastes the entire look of the cue including any tracked programming that would have contributed to the look onstage.

· Paste only the events
This pastes just the events in the cue and disregards any tracked programming that may have contributed to the look onstage

· Alias cue.
An Alias cue is a unique copy that retains a direct link to the original cue it was created from. That means that when you update the original cue the alias cue is also updated, and vice versa. 
Chases

Create a new cuelist as a par chase (Using store)

Timeline
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By using the timeline, you can easily see the events in your cues laid out over a period of time and visually perceive how your changes, will look on the stage. Remember that your show is not only about the final look of the cue but it is as much about the transition and how it gets to that state. 

The Timeline shows your lighting states as a series of events which are broken down into the feature categories of:

· Intensity (Blue)

· Position (Purple)

· Colour (Yellow)

· Gobo (Light Blue)

· Beam (Green)
1. “Events” are shown for each change in a cue

2. Selecting events

3. Drag to change times 

4. Double click to enter times
5. Interaction between default times and timeline events

6. Timeline sorting, “summaries” and filters
7. Zoom Functions
8. Cut, copy & paste in the timeline – different to fixtures!
Exercise - Create a Rock and Roll Fly-out Sequence.


Cue 1 - All fixtures pointing at stage



Cue 2 - All Fixtures Fly up into the roof over 2 seconds



Cue 3 - All Fixtures Fly back to the stage one by one from one end over 3 


seconds.
Modifying an existing cue
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Click on it and go…
The timeline allows you to quickly move between multiple cues and edit both in sequence and out of sequence. 

1. Cut, copy & paste in the timeline – different to fixtures!
2. Link and Sync

3. Editing existing events

4. Selecting Fixtures Vs. Selecting Events. 

Move in black 
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Mark Cues (Move in Black) is a function that automatically moves a light into position before the intensity comes up.
There are two parts to a Mark Cue. 


The Move in Black Cue - The cue where the fixtures will present the features to be ready for the intensity to come up, in the subsequent cue. 


The Mark Cue - The cue where the intensity will fade up, the cue this is the cue with all of the programming information for the fixtures.  

The beauty of the Mark Cue function is that it allows you to edit the Mark cue and the Move in black cue will be automatically updated. 

· Tools Menu > Mark Cue (Move In Black).
· Select Existing Cue, Insert a new Move in black cue

· Marked Features

· Marked Fixtures

· Disable Move in Black 

· Auto Move In Black on a Cue list Level
Exercise – Move in Black


Create a new cue list. 



Cue 1 - Fixtures in blue in a position with a gobo

Cue 2 - The same fixtures intensity fade to Zero

Cue 3 - The same fixtures fade up to full, in green in a gobo in a different position



Place a Mark Cue at cue 2.5 to preset the fixtures for Cue 3

Update Cue 3 with the fixtures in Pink and in a different position. 



Watch the updated mark cue. 

Cue Start Mode (Follow Time)
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The default action for a cue list is to make all of the Cues "Halt" Cues. This means that the cue list will wait at the completion of the cue until the operator presses the play button to continue to the next cue. There are also other options to create an automatic cuelist.

Cue Start Modes.
1. Halt

2. Follow - Automatic start mode that will start the countdown from the end of the previous cue. 
3. Start - Automatic start mode that will start the time countdown from the beginning of the previous cue. 

4. Timecode - will be covered later. 

Insert Commands (Advanced)

Insert commands can be inserted into cues to trigger alternate actions. Such as playing or releasing another cuelist. Insert commands appear as an event on the timeline and can be manipulated like any other event. (except for event timing)

· Tools > Insert Command

· Insert command actions

· Manipulating an inserted command

Exercise – Create a new cuelist

Work through creating a new cuelist, to the intro to "Bring me to Life" By Evanescence, then play it back. 

Cues:

1. Rotating B/up gobo wash in blue, turned on 1 by 1

2. Add singer in movers

3. Build for band – ML’s start in Audience, move to rest of band.
4. “Home” Blackout

5. Big open white fly-in to stage.
6. Follow on to base band look.
7. Strobe accent.
8. Restore to cue 6.
Understanding Tracking

Let's look at tracking in this cuelist that created and what happens to other cues when you make changes to one cue.
· View entire cuelist

· Timeline > Show Tracked Events
Block Cues
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Block cues are a way to block tracked information from entering your cues. If you place a block on your cue the "look" of the cue and subsequent cues will be maintained, regardless of any programming you insert in preceding cues. 

Exercise – Block Cues
Use the Cue 4 blackout as an example
· Add a new fixture to Cue 3.

· See the resulting blackout.

· Remove the new fixture and Block Cue 4.

· Add the new fixture again to cue 3.

· Watch the blackout cue again. 
Cue Only Mode

Cue Only mode is a mode that you put the cuelist into where it acts as if all cues are blocked, for that period. It means that when you edit the cues, the programming will only be inserted into the cue you are editing and tracking is ignored.  
· Tools > Cue Only Editing
SmartFx
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FX Templates

Vista comes with a pile of preloaded Fx templates, these templates are found under our components tab and you can also find them by changing the quickpicker to Fx Templates. These preloaded fx cover a wide variety of the standard effects that you will want to use in your show. 

· Position, Colour, Intensity, Video and Beam Fx

· Applying Fx Templates

· Adjusting Fx Templates 
Creating a new Effect

Fx Types

· Wave Effects - Also known as waveform effects, these effects apply a waveform across certain attributes to create an effect. 
· Swing Effects - These effects follow a series of steps in sequence.
· Video Effects - Specifically for Matrix Programming. 

· Select Fixtures

· Smart Fx Dialog

· Create New Effect

· Effect Types

Exercise – Creating Effects
· Create a Colour Wave Effect

· Create a Colour Swing Effect

· Create a Position Wave effect
Modifying an Effect
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You can modify any running effect using the smart effect dialog.

· Base

· Customise

· Sequence Tab

· Sort Fixtures

· Spread Shape

· Multi Element Fixture Selection

Effects Controls
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· Rate

· Rate Divider

· Size

· Overlap

· Stagger

· Blocking 

· Repeats

Stopping an Effect
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It's all well and good to start an effect but it's also quite important to be able to stop it. 

· Tools > Stop Smart Fx

· Stop All Fx

· Stop Intensity Fx

· Stop Position Fx

· Stop Colour Fx

· Stop Gobo Fx

· Stop Beam Fx

· Stop Fx Functions on Soft Key Toolbar

· Stop Fx Functions underneath parameter categories in sidebar. 
Arranging your console
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Once you have created all of the parts of your show, one of the most important parts of your show is arranging the console in order to playback the show in the most efficient way that suits your operating style. 

Vista makes it simple to arrange your components onto the console using the visual Console window. 

· Adding/deleting consoles

· Component sidebar

· Button and Fade actions sidebar.

Playbacks
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The playbacks are the positions we can use to place the components of our show. 

1. Arranging playbacks

2. Expanding/splitting playbacks
3. Playback Right Click Menu

Cuelists on playbacks
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Drag and Drop from sidebar

Button actions

Fader Actions

· Intensity Fader

· Cross Fader 

· Fx Rate and Size

Exercise – Changing Fader Actions

Create a new cuelist that contains a position effect.


Change the Fader action to Fx size


Change the Fader action to Fx Rate
Groups on playbacks
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Group masters

Button  actions 


Select


Flash (-) - Flashes the group down to zero from the current output level


Flash (+) - Flashes the group to Full from the current output level


Flash (HTP) - Flashes the group to full from the current output level using HTP

Fader Actions


Scale (-) - Scales the group down to zero from the current output level - Similar to an 
inhibit fader


Scale (+) -Scales the group to Full from the current output level


HTP - Fades the group to full using the HTP Rules

Pages
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One of the advantages of Vista is that each playback section can be paged through individually. 

· Page Up/Down Buttons

· Page Holdover 

Presets and effects on playbacks

Just for selecting like the Quick Pickers – no “playback” controls.
Exercise – Using Show Components

Create a playback layout for the show using the components we have 
created so far. 
Super Playback
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Using it for cuelist playback
· Menu > Play

· Selecting a cuelist

· Fader Actions

· Control

· Chase

· Smart FX - Adjust rate and sync of Smart Fx that are running from Cuelists

· Play, Pause, skip Forward, Skip Back. 
Jump

The jump function allows you to jump to cues out of sequence. You can quickly and easily move between cues in your show.

· Tools > Jump. 

· Jump in Superplayback

· Select Cue

· Cue Timing vs. Live Timing

· Arm and Close. 

Extras

· Playback Control Window

· Output Window

Snapshots
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Snapshots allow you to store and recall the exact state of the console’s output, buttons, faders and other controls. They can be used to quickly re-configure the controls for playback, programming or a mixture of both. For example, you may have a snapshot set up for each song or part of a show. You might also have a snapshot for programming with the playback buttons assigned to provide quick access to Groups, Presets Extracts and Effects.

Snapshots can not only recall Page and Cuelist settings but also the state of the Cuelist. For example if a Cuelist is active and in Cue 3 when the snapshot is recorded then the same state can be recalled.

· Creating Snapshots

· Recalling Snapshots

· Filtering Playbacks stored in snapshots

· Snapshots in QP
Command Line 

As well as being an extremely visual console, Vista also allows you to work in a command line if you need direct access to fixtures via there fixture Id. 

· View > Command Line

· Command line in Fixture Chooser
· Fixture @ Level Enter

In the patch window you can also use the command line to patch dimmers. 

· Patch Type defaults to dimmer

· Fixture @ Address

· Multipatch via command line
Exercise – Patch Using Command Line
Patch fixtures 1001 through 1010 to Universe 8 Address 1 using the Command line patching method.
Tracking Back Up
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With Vista’s tracking backup feature you can connect a computer, running the Vista application, or a second console that synchronises it’s show file and settings with your main console. If the main console fails for any reason, the backup system will automatically take control.

The backup system automatically copies the show programming from the main console and you can start or stop them in any order and at any time.
· Networking two consoles/applications

· Setting IP address/Subnet Mask

· File > Networking
· Tracking Backup Config

· Identifying Network Nodes

· Console Name

· Console Group

· Failover Timeout

· Loss of Comms Timeout

· Network Role

Exercise – Setting up a Tracking Back up System
Create a network of two consoles

· Run a Master/Slave system

· Experiment with automatic/manual failover

D1 Distributed Processing. 

MANUAL REFERENCE

The D1 Distributed Processing unit connects to any Vista Console to share the processing load and increase the processing capacity of any console. The D1 is in itself a self contained Vista Console dedicated to providing expanded processing capabilities. 
· Introduce D1 hardware

· Introduce D1 Touchscreen - Home Screen

· Configuring D1 IP Address

· Port A/Port B

· Setup window

Press the setup button to configure additional D1 settings.

Here you can change the name and group settings directly from the D1.  The name must be unique and the group must be the same as all the other devices you wish to connect to.  This can be done later from the console.

· Monitor window

This window will give a summary of the dmx outputs being sent on the D1.

· Indicator Lights

The front panel has indicator lights for power and hard drive activity.  The network LED light will light up once the D1 is connected to a master. The DMX 1-8 activity lights will indicate when dmx is being output via one of the physical dmx ports on the rear of the D1.

· Connecting the D1 to a console Using the networking dialogue

· Byron Statistics

· Shutting down the D1

Press the power button once and tap shutdown on the LCD to complete the shutdown.
Configuring the DMX and Ethernet Outputs for Networked DMX
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Vista allows you to not only output standard DMX 512 but it also allows for Ethernet DMX to expand your control output and options. 

· Connect Universes Dialog

· Add Network Connection

Artnet

Artnet is an open protocol implemented by Wayne Howell from Artistic License. The artnet protocol allows for transmission of DMX traffic over Ethernet. 

· Artnet Broadcast

· Artnet Unicast
· Gateway Address!

Artnet Settings - User Preferences Networking

· Subnet Directed

· Artnet Primary 

· Artnet Secondary 

· Limited Broadcast
Pathport

Pathport Protocols are proprietary protocols from Pathway connectivity. 

Streaming ACN

Streaming ACN or sACN is a Standard protocol developed by the PLASA organisation. The advantage of sACN is it allows for more directed network traffic and priority options

· Priority Settings 

Timecode
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You can use linear timecode or Midi time code in Vista to trigger cues. The timecode source can either be the Vista internal timecode or an external source such as SMPTE timecode. 

There are 3 main steps to setting up your console to work with timecode:

Configuring the Timecode Source
In order for Vista to respond to the correct timecode input, the time code source must be selected.

· File > Timecode 

· Timecode Source

· Frame Rate

· Timecode Offset

· FreeWheel
Enabling Timecode on the Cuelist 
A cuelist will not respond to timecode unless the timecode has been enabled under the cuelist properties. 
· Cuelist properties

· Enable Timecode

· Difference between Enabling and Arming a cuelist

Setting the Timecode Trigger Points

Time code trigger points can be added manually or can be added automatically by using the learn timing function

· Learn Timing.
· Maintain cue duration. 
· Manual input Timecode values

Playing back with Timecode

In order to playback a time code triggered cuelist the cuelist must first be armed, this gives vista the signal to start listening to the timecode in order to play back the cuelist. 

· Arm Cuelist

· Arm All Cuelists

· Play, pause and rewind timecode points

Exercise – Your Timecode Cuelist
· Open the Cuelist we programmed to Evanescence
· Enter the timecode values using learn timing
· Play back the cuelist to music using the internal timecode as the trigger
Media Servers
A key feature of Vista v2 is its seamless control of media servers. Once connected to a media server you can see thumbnails of the clips on the screen, aiding efficiency, no need for labels  or reading abbreviated descriptions – just pick the one you want. 

Connectivity to media servers also expands the possibilities of the console. This offers a simple way to achieve total control over all visual mediums of the show.
Connecting to a Media Server

Connecting to a media server consists of two parts:

1. The CITP connection to the server to allow for media import
2.  The control connection to the server
Patching the Server

A media server like any other fixture must be patched to a DMX output in order to be controlled. 

A server is usually made up of two parts:

· A Master Server - This is the master server, this part of the server contains all of the master controls

· Layer - The layer controls the image content of the server, you can have multiple layers as part of a server, as many layers as images you need to overlay. The maximum number of layers is defined by the server that you are using. 
Exercise – Patching a Media Server
Patch an Arkaos Media Master Full Server 1.0

Patch 3 Arkaos MediaMaster Layer Full 1.0
CITP Connection

CITP allows for the import of image thumbnails from server to console to make selecting images from the console easier. 

There are two main process to import the thumbnails into vista.

1. Importing the thumbnails

· Assign IP Address/Subnet

· Patch > Import Media Server Thumbnails

· ImportThumbnails

2. Assigning the thumbnails - The imported thumbnails must be attached to the relevant server for Vista to recognise them. 

· Search for the server

· Right Cick > Use Custom Media.

· Browse to the Relevant Folder

Exercise – Importing Thumbnails
· Import thumbnails from the Arkaos Media Server.

· Attach Thumbnails to relevant server and layers.

Control Connection

Vista uses a DMX protocol to talk to media servers, just like it does with other fixtures. The server you choose will determine the method of control:


Options:

· DMX

· Ethernet Protocol (Artnet).

Exercise – Connecting Media Servers
· Connect to the Arkaos Media server using Artnet. 
Controlling a Media Server

Once a Media Server is patched and the thumbnails are assigned, the control of a media server is extremely simple as they are controlled in the same fashion as any other fixture. 
· Media servers in the Fixture Chooser

· Selecting content - Gobo > Media File

· Media Content in the timeline

Because Vista treats Media servers like any other fixture, we also map the generic controls of a Server to the generic fixture controls:

· Intensity

· Pan/Tilt

· Colour

· Zoom

· Cut Copy/Paste between fixtures and servers

The key to operating a media server is to understand your server and the control options that it allows you. There are a few media specific control options that we as lighting people may not have seen before:

· Keystone

· Mask

· Offset X and Y

· Scale X and Y

Exercise – Creating a State with a Media Server
Create a state with your media server 
· Layer 1 - Image with full mask - Luma Key, coloured red. 
· Layer 2 - Image with full mask - Luma Key, coloured green, positioned top right
· Layer 3 - Image with full mask - Luma Key, coloured red, positioned bottom left
Storing a Media Server
The beauty of using a media server in Vista is that storing a server into a cuelist or a preset is achieved in the same way as with other fixtures

· Creating a Media Preset

· Creating a Media Cue

Exercise – Media Presets
· Create two media presets

· Use these media presets to create a cuelist, start to experiment with fade times. 

Matrix Programming

One of the unique features in Vista is the matrix. A matrix allows you to insert a number of fixtures and apply group programming to them. This allows for unique video style effects across your fixtures. You can also place fixtures of different types in a matrix.
· Creating a matrix

· Adding Fixtures to a matrix

· Removing Fixtures from a matrix

· Resizing a Matrix

· Applying an Effect across a matrix

· Matrix events on the timeline

· Matrix programming vs. Individual fixture programming

GIF Images on a Matrix

You are also able to place Gif Images across a Matrix to be played back, with each pixel in the gif being played back across one square in the matrix. 
· Starting a Video Fx

· Importing a Gif Image

· Scale

· Rate
Fixture Editor
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The Fixture Type Editor is a separate application to the Vista software that allows you to build new fixture types, import fixture type files or edit existing factory fixtures. The Fixture type editor relies on you having access to the DMX chart for the fixture that you are trying to build or edit, or if you are importing a fixture you must have a valid .fix2 file.

Factory Library
The factory library installs with the application software and consists of all of the fixtures that have been added at the Jands factory. This library can't be edited and is only updateable via a new software installation.

· Searching for fixtures

· Opening an existing fixture

User Fixture Library
The User Fixture Library is your editable library and will contain all new, edited and imported fixtures. 

· Importing a Fixture

· Duplicating a fixture from the Factory Library

· Creating a new fixture

Creating/Editing a Fixture.

The Fixture Type editor allows you to create and edit your varied fixture types. These created fixtures will only appear in the User Fixture Library. 

NOTE: TO EDIT AN EXISTING FIXTURE YOU MUST FIRST COPY THE FIXTURE FROM THE FACTORY LIBRARY. 

· Creating a new fixture

The Fixture Editing Dialog

· Main Tab - Enter all of the General Fixture data such as manufacturer and name

· DMX Chart Tab - Enter all DMX channel assignments and channel range values

· Dmx Macros Tab - Enter data for all of the control macros, including strike douse and reset

· Notes Tab - Add personal notes relating to the fixture

· History Tab - Keep a chronological history of the fixture
Main Tab

· Manufacturer

· Full Name

· Short Name

· Complete

· Beam Type

· Frame Type

· Movement Type

· Physical Type

· Light Generation

· Maximum Pan/Tilt

· Element Count

· Scroller

· Patch Part

· UUID/Compatibility ID
DMX Chart Tab

Work through creating the VL1100AI Fixture

· Adding a DMX Channel

· Feature

· Class

· Channel

· Default Value

· Adding a 16 bit channel - Pan/Tilt

· Adding a Colour Mix Channel

· Adding a Gobo Wheel

· Adding slots to gobo wheels

· Determining rotate modes

· Adding a rotation channel

· Adding control channels

· Adding ranges

DMX Macros

· Creating DMX Macros

· Correct Macro Format

· Channel Number @ DMX Level # Time to hold channel in Milliseconds

· Separate multiple actions with a semi colon. 

Exercise – Creating Fixtures
· Create a generic LED RGB Par

· Create a MAC 700 Profile Basic

Product Support
If you have a problem or need to ask a question the following resources are available:

Jands Lighting Support

For questions relating directly to the consoles including application functionality, reporting bugs and suggesting new features the Jands Lighting support team can be contacted directly via our web form which is located at http://jands.com/support.

You can also email support@jands.com.

Alternatively contact your local dealer or national distributor.

Jands Lighting User Forum

Jands Lighting has a forum where users can share their ideas and experiences. This is free for anyone to join and can be found at http://jands.com/forum.
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